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Think Nationally, Act  
Locally: LLSDC Members 
Advocate in AALL’s 2014 
Lobby Day

Emily R. Florio, Judy Gaskell, Elizabeth Holland,  
Mary Kate Hunter, Melanie Knapp & Mary Jo Lazun

Research shows that nothing is more influential to a member  
of Congress than a meeting with his or her constituents. As the  
participants in our 2014 Lobby Day experienced firsthand, members 
of Congress and their staff are often eager to learn about an issue 
from those who are impacted by it and, in turn, will use the opinions 
of constituent experts to inform their views and cast their support. 
This kind of civic engagement leads to more efficient and effective 
decision-making—and it’s fun! 

The strength and success of AALL’s advocacy program relies on 
the participation of individuals and chapter members who dedicate 
their time and talents to advocate on behalf of their profession. 
AALL members and chapters across the country—including  
LLSDC—have helped to make the Association a leading voice on 
state, national, and international legal information policy issues. 
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AALL and LLSDC have had a direct impact on the 
legislation that influences law libraries, from access 
to authentic government information to balance 
in copyright law, protection of patron privacy, and 
more. This year’s Lobby Day participants made a 
difference in a House bill and a Senate bill.

On Thursday March 27th, AALL members from 
Maryland, Virginia, the District of Columbia, and 
other parts of the US attended Lobby Day on  
Capitol Hill. The morning consisted of lobby  
training and issue briefing led by Elizabeth  
Holland and Emily Feltren from AALL’s Government  
Relations Office in DC. The members also had  
a visit from a long-time Hill staffer, currently an  
attorney for the Senate Judiciary Committee,  
for an “insider’s view” of effective constituent  
advocacy. Armed with information on how to 
tackle the issues and how to deliver the message, 
members spent the afternoon lobbying on the hill.

After the excellent morning briefing, the  
delegations split up. The Maryland delegation  
included Steve Anderson and Mary Jo Lazun  

from the Maryland State Law Library, Joanie  
Bellistri from Anne Arundel Circuit Court Law 
Library, Tonya Baroudi from the Prince George’s 
County Circuit Court Law Library, and Jill Smith 
from Georgetown University Law Library. 

One of their big issues was opposing H.R. 4195, 
the Federal Register Modernization Act. The Act 
would eliminate printing and indexing of the  
Code of Federal Regulations (CFR). When Mary  
Jo and Joanie met with their Congressional  
Representative, he suggested visiting Elijah  
Cummings, whose committee was handing that 
bill. The staff at Congressman Cummings’s office 
was very open when listening to their concerns 
and asked them to follow up with an email and 
more details. The feedback was positive, and the 
delegation was assured that AALL’s concerns  
would be addressed. 

Later, the Maryland delegation visited the offices 
of Senators Cardin and Mikulski. Senator Cardin 
himself stopped by to say “hello” and ask about 
the issues. The delegation had good conversations 
with both Senators’ staff; they listened attentively, 
asked good questions, and promised to follow up. 

As the participants in our 2014  
Lobby Day experienced firsthand, 

members of Congress and their staff 
are often eager to learn about an issue 

from those who are impacted by it  
and, in turn, will use the opinions of 

constituent experts to inform their 
views and cast their support. 

The staff at Congressman  
Cummings’s office was very open 
when listening to their concerns  

and asked them to follow up with  
an email and more details. The  
feedback was positive, and the  

delegation was assured that AALL’s 
concerns would be addressed. 
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Four DC librarian residents (Scott Bailey, Emily 
Florio, Judy Gaskell, and Melanie Knapp) met with 
Jason Spear, a Legislative Associate in the office 
of DC Delegate Eleanor Holmes Norton to request 
that the Congresswoman co-sponsor FASTR (H.R. 
708) and oppose FIRST (H.R. 4186). FASTR (Fair 
Access to Science and Technology Research Act) 
would fuel scientific discovery and innovation by 
requiring all articles resulting from publicly funded 
research to be made freely available within six 
months, whereas FIRST (Frontiers in Innovation,  
Research, Science and Technology Act) aims to 
significantly limit public access to scientific  
research by extending the publishing embargo  
to three years. Due to the group’s lobbying  
efforts, Congresswoman Norton signed on to  
co-sponsor FASTR! 

Judy Gaskell has connections to Wisconsin. She 
met for the second year in a row with Erik Fawcett, 
the Legislative Assistant for Representative Gwen 
Moore of Wisconsin. Despite a good conversation 
with him and a follow up email to him,  
Representative Moore has not yet signed on as 
a cosponsor to the Email Privacy Act (H.R. 1852). 
However, if action is taken on the bill before the 
end of the year, Judy will contact him again to  
remind him of AALL’s concerns, or thank him if  
he supports the Email Privacy Act. 

The Virginia delegation, composed of Amy Taylor 
from American University’s Pence Law Library,  
Mary Kate Hunter from the George Washington 
University Law Library, and Anne Mira Guha,  
a student in Catholic University’s MSLIS program, 
first met with the staff of Representative Jim  
Moran, with whom they discussed H.R. 4195, the 
Federal Register Modernization Act. The staff was 
particularly interested in the negative impacts that 

the elimination of a print CFR index would have  
for both librarians and our patrons. They were very 
receptive to AALL’s concerns and asked to have 
AALL send a letter to the office with more  
information about H.R. 4195.  

 
Later in the afternoon, Melanie Knapp from 

George Mason University Law Library joined  
the Virginia group for meetings with the staff  
of Senators Mark Warner and Tim Kaine. The  
delegation had a very productive meeting with 
the staff of Senator Warner regarding S. 1947, the 
Government Publishing Office Act of 2014, which 
would change the name of the Government  
Printing Office to better reflect the services GPO 
now provides in the digital age. Shortly after  
Lobby Day, the Senate Rules Committee favorably 
reported out S. 1947, and it is now ready for  
consideration by the Senate. At Emily Feltren’s  
direction, the delegation followed up with the  
staff from Senator Warner’s office to thank them  
for the Senator’s support of S. 1947 and to work  
on developing a lasting relationship with his staff.

As you can see from the success of the DC  
librarians in obtaining Delegate Holmes Norton’s 
support of FASTR and the Virginia librarians  
influence on the Government Publishing Office  
Act, AALL and LLSDC members can truly make a 
difference in lobbying efforts. We strongly urge  
you to partake in Lobby Day next year!

Due to the group’s lobbying  
efforts, Congresswoman Norton  
signed on to co-sponsor FASTR! 
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From the Editor

Summer is a Time for  
New Ideas and New  
Approaches

Ann Baum
Librarian, abaum826@gmail.com

Submission Information

If you would like to write for Law Library Lights, contact Ann Baum at 
abaum826@gmail.com.  For information regarding submission deadlines 
and issue themes, visit the LLSDC website at www.llsdc.org.LLSDC

LAW  LIBRARIANS’  SOCIETY  OF  WASHINGTON, DC

Summer is finally here.  After this past winter, I think we are all 
ready for some warmth and sun.

Summer also means the last issue of the current publishing cycle.  I have had a wonderful time as 
your editor for the past year, and I have enjoyed reading all of the articles that have been submitted  
for publication.  For the fall issue I will be handing my editing duties over to Judy Gaskell.  Judy has 
done a great job as assistant editor this past year and I know that she will continue to make Lights a 
publication that is both informative and entertaining.  Please join me in wishing her good luck in  
her new position.

We have some great articles this issue that I hope you all find of interest.  First, we have a recap of  
the Lobby Day activities arranged by LLSDC.  Some of our fellow members met with various members 
of Congress to discuss topics close to the hearts of many librarians and to learn about proposed  
legislation that will affect libraries and legal research.

Next we have an overview from Tracy Woodward on how to create training videos for your library.  
She takes us through the steps to craft the most effective presentation, and has even included a video 
for us to watch.  Technology marches on, and we need to keep up.
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From the Editor, Continued

For this issue’s book review, Dawn Bohls read a book that should be of interest to younger lawyers.  
Making Partner provides a guide to navigating the early stages of a new law career, and Dawn covers 
what seems helpful and what she thinks new lawyers might actually do best to avoid.

And in our latest Tech Talk column, Roger Skalbeck looks at the new innovations in e-books with  
regard to how they can be used in law schools.  Hard copy books hopefully aren’t going anywhere  
any time soon, but e-books are certainly here to stay and we should make the best use of them that  
we can.  Not to mention the fact that students appreciate anything that saves them having to tote 
around those heavy casebooks.

Summer may be a slow time for many of us, but fall is just around the corner.  New associates and 
new students will be coming to our offices and campuses and we need to be ready for them.  Having 
the right materials for them and teaching them how to use those materials will always be an important 
part of a librarian’s job, no matter how much technology changes.  Hopefully this issue can help you 
plan for some of those eventualities, or inspire you to devise solutions for problems we haven’t even 
faced yet.  Until then, happy reading.

Member Spotlight

Michael Timpani

Congratulations to Michael Timpani on winning  
the National Library Week Lexis Nexis contest.   
His prize is an all expenses paid trip for two to  

the Presidential Library of his choice.
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Events Edge

Alicia Pappas
LLSDC Arrangements Chair

Senior Associate of Library Services, KPMG LLP, apappas@kpmg.com

Summer is HERE!
At the Closing Reception on June 3rd, we watched as Ed O’Rourke passed the gavel to  

Mary Kate Hunter, the current LLSDC President.  Hosted by Finnegan, LLSDC members got to 
enjoy some sunshine (and DC summer heat!) up on the rooftop with a beautiful view of the 
Capitol and Washington Monument.  It was a great night to celebrate the outgoing board 

and welcome our new officers.
 

In May, LLSDC’s Town Hall meeting was honored with the keynote speaker of David Mao,  
Law Librarian of Congress.  Those who attended heard him speak on the constant  

relationship between the Library of Congress and the Society since its start in 1939.  
Then, President Ed O’Rourke gave a recap of a how the society is doing and opened  

the floor to questions and comments about the future of LLSDC.
 

Member Spotlight, Continued

FOR 2014 ONLY!

In honor of LLSDC’s milestone achievement, we want to encourage all DC 
law librarians to be a part of the society’s history.  LLSDC is offering a 10% dis-
count to all new members* signing up this year.  Please forward this amazing 
opportunity to your colleagues and peers who might be interested in joining!   

Contact Alicia Pappas for more details on how to receive this discount.
(*must not have been an active LLSDC member for over one year.)

Upcoming events this summer will continue the themes of collaboration and celebration  
as we have our second annual Nationals game outing as well as add a new twist on the  

mailto:apappas%40kpmg.com?subject=Getting%20involved%20in%20LLSDC
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Battle of the Librarians trivia event.  There will also be a rare book tour at the Library of  
Congress open only to a small group, so check your email to make sure you don’t miss  

out on this cool opportunity! 

Do you have amazing event ideas?  Ways to improve LLSDC? Or do you just want to be  
more involved and give back to your professional community?  Email volunteer@llsdc.org 

and find out how you can help today!

Check the LLSDC Calendar for all upcoming events and be sure to follow us on  
Facebook and Twitter for more photos and fun!

Member Spotlight, Continued

mailto:volunteer%40llsdc.org?subject=
http://www.llsdc.org/events-calendar
https://www.facebook.com/pages/LLSDC/175471305731%3Fref%3Dhl
https://twitter.com/llsdc
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Adam Gropper, Making  
Partner: The Essential Guide 
to Negotiating the Law School 
Path and Beyond (Chicago: 
American Bar Association, 
2013)

Dawn Bohls
Reference Librarian, Bingham McCutchen LLP
dawn.bohls@bingham.com

Those of you who have followed my book reviews over the years may remember that back in the  
Winter 2011 issue of Lights, I reviewed the book Practical Lawyering: The Skills You Did Not Learn in  
Law School.  I was a bit disappointed with that book because I had expected more of a focus on the 
challenges faced by associates at AmLaw 100 firms, whereas Practical Lawyering was really directed 
towards new lawyers in much smaller practices. What I had expected was a book more like Making  
Partner, which specifically addresses the path to success in the world of BigLaw, from law school 
through life as a junior partner.  

Author Adam Gropper was a tax lawyer with Baker & Hostetler LLP from 1999 through 2009 and  
made partner in 2007, presumably by following much of the advice he lays out in his book.1  
Nowadays he works for the Joint Committee on Taxation and has a blog on law firm life aimed at  
law school students and associates.2  One thing I feel sure of about Gropper: he is not a shy person.   
He approached a fellow LLSDC librarian about having his book reviewed in Law Library Lights. He then  
sent me a free copy of the book, and followed up by e-mail to see whether a review was actually going 
to be published.  I was a bit surprised that someone would be so assertive in seeking a book review,  
but after reading Gropper’s book, I can see that he is merely following the very tactics he advocates!

Most of Gropper’s advice for law school students is pretty standard and straightforward, and makes 
a lot of sense. For example, he tells students to get good grades, especially early on, to help them get 

Book Review
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people [p. 27]. Ouch! I’m not sure my ego  
would survive so much rejection. 

Assuming that you manage to get hired as  
an associate in a top law firm, your job as an  
associate is to make your clients happy. And 
when you’re an associate, your clients are not  
the firm’s clients; your clients are the partners 
you work for. They are the people who give  
you work, evaluate your performance, and can 
make or break your progress with the firm. 

Gropper offers some really good advice for  
new associates about dealing with partners  
(or anyone giving you work) and finding out 
what they expect from you, and also for  
communicating your progress on assignments. 
It’s also important to document your  
achievements; even the partners you work for 
regularly don’t know everything you’ve worked 
on (or they may have forgotten).  Seeking  
regular feedback on your work and having an  
effective “sponsor” for your career are other 
excellent tips.

Gropper ends the book with two shorter  
chapters offering advice for actually making 
partner (or at least making your case for why  
you deserve to make partner) and then for  
succeeding as a junior partner. Understanding 
the business of law and demonstrating your 
ability to generate revenue for your firm have 
become essential elements for these years.  
Don’t think you get to relax and rest on your  

Book Review, Continued

summer associate offers from firms they’d like 
to work for [p. 2]. He offers some helpful tips for 
picking a law school “major” such as determining 
what practice areas are in demand, which might 
suit your personality and skills best, and how 
your prior background can come into play.  
Gropper himself had undergraduate and  
graduate degrees in accounting and tax, so  
specializing in tax law seems to have been a 
natural choice for him.  

So far, so good. But from there, things get a  
little more challenging for the introvert. In  
Chapter 2, which is only a few pages long,  
Gropper starts emphasizing the importance of 
self-promotion and salesmanship. “If you are not 
comfortable as a salesman,” he warns, “plenty of 
quality legal jobs are available, but perhaps a top 
law firm . . . is not the best place for you” [p. 17]. 
Chapter 3 gets into some tactics that are not for 
the faint-hearted. 

A good suggestion he makes is to contact 
and meet with alumni from your law school to 
learn more about the day-to-day practice of law, 
find out more about practice areas and firms 
that might interest you, and make contacts that 
might be helpful as you seek that first job and 
move forward in your career. More intimidating 
is the realization that your attempts to set up 
meetings might be rebuffed or even completely 
ignored more often than not. Gropper suggests 
that you’ll be lucky to set up a few face-to-face 
meetings after starting from a list of 50 to 100 
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Book Review, Continued

laurels just because you’ve made partner!  
The first years as partner are a critical transition  
period during which you need to show that  
you can cultivate business both from current 
clients and from new ones. 

At only 86 pages, Making Partner is a short 
book, but it packs a lot of useful tips into  
those pages. I was not comfortable with all  
of Gropper’s advice. A few of his suggested  
tactics require a degree of aggressive  
self-promotion that would not be appropriate 
in all circumstances and could definitely turn 
off some potential supporters. Someone using 
this book certainly would need to use judgment 
about which particular strategies would be most 

effective given the personalities of the people  
in question and the culture of the firm.  
Nevertheless, I think every law school student 
and BigLaw associate, and even people just 
contemplating a future in BigLaw, would benefit 
from reading the book. You definitely get a feel 
for the sort of mindset and qualities necessary 
for long-term success in a large law firm. And at 
just under $50, it’s a good candidate for addition 
to any law firm library’s collection, even in these 
budget-conscious days.

Notes
1See LinkedIn profile at http://www.linkedin.com/pub/

adam-gropper/5/149/629. 
2Follow Gropper’s blog LegalJob at http://legaljob.com/. 

A FEW PARTING WORDS

With this column, and with mixed feelings of relief and regret,  
I am signing off after five years as Law Library Lights’ book  

reviewer. It’s been a great pleasure and privilege to write for  
all of you about a variety of interesting and perspective- 

broadening books that I never would have read otherwise,  
but I hope that someone else will appreciate the opportunity  

to step in and take over this very rewarding task, and I look  
forward to reading my successor’s book reviews!

Editor’s Note
Thank you, Dawn, for your five years of service to  

Law Library Lights and to LLSDC. 
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How To Make a Law Library Services Video  
Using PowerPoint 

Tracy Woodard
Legislative Librarian, Katten Muchin Rosenman LLP, tracy.woodard@kattenlaw.com 

Recently, I used PowerPoint 2010 to create  
legislative research services videos for the firm 
library. It is easy to create a polished video that 
highlights law library services. 

Digital projects should begin with project  
planning, including: content and design, targeted 
users, media compression and dissemination  
options, and cost considerations. This article 
doesn’t discuss project planning. To meet the  
gap, I’ve included a selective bibliography that  
addresses some aspects of project planning. 

This is a how-to article designed to help  
you create a law library services video using  
PowerPoint. 

Here’s How To Make a Law Library Services Video 
Using PowerPoint (click the image below):

General Recommendations
Keep passwords and sensitive information off the 

video, try to keep the video under 3 minutes, focus 
on content, make sure the spell-checker is turned 
on, lots of editing and fresh-eyes review, and avoid 
using too many animations.  

PowerPoint 2010 

Make sure you are using PowerPoint 2010 or 
higher.  PowerPoint 2010 has a simple button 
named “Create a Video” that we will use to finish 
the video project.

 Right click on the PowerPoint icon and  
Click > Properties.

Haute Couture 

Open PowerPoint and select a blank presenta-
tion. Add style and pizzazz later. You may decide to 
get permission and add an appropriate Instagram 
photo, iStock media, or tasteful animation and 
background color. However, the content is most 
important, so we will manage that first. 

Click File > New > Blank presentation. 

Create the Presentation

The first slide is the title slide. Use the second 
slide to define library services and to promote  

1.

2.

3.

http://youtu.be/-fm0ulfaWZc
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accomplishments, a departmental resume,  
so to speak. On the last slide, include contact  
information of key-people.

Click Home > New Slide. 

For example, I use the second slide to report  
billable hours of completed projects and to  
generally promote library accomplishments.  
For example, the second slide could show the  
following: We provide ___; We completed  
___ billable hours towards the major project;  
We analyzed ___ for the firm’s global  
digital resources. 

Create the Narration Script

You’ve already created the presentation, which 
highlights the main topics. Now, use  
the “Notes Pages” to type the content of the  
narration script that you will read from. Print the 
“Notes Pages” and use it as your narration script. 

Click > View > Notes pages. 

Record the Narration

If you have a smart phone, you have a recording 
device. 

Read and record your narration script onto your 
mobile phone. Email the voice file to yourself and 
save it to your desktop. 

From your Android phone Click > Voice  
Recorder > Record > Share Via > Email.

Note: There are a handful of audio files that are 
compatible with PowerPoint 2010. If your voice file 
is not one of the compatible extensions, then you 
must convert it. Convert your voice file to a .wav file 
using the free version of RealPlayer or a software 
you trust. Per MicrosoftOffice.com, compatible  
extensions: .wav, .wma, .mp3, .aiff, .au, .mid or .midi.

Add the Voice File to the  
Presentation

Insert your voice file into the presentation.
Click > Insert > Audio > Audio from File. 

Make the Voice File Play  
Across Slides 

Make the voice file play “play across slides,” and 
hide it during the show. 

Click > Audio Tools > Playback. Select > Start: 
Play Across Slides. Select > Hide During Show. 

Record the Presentation 

Rehearse or record the presentation. Both  
options record the show and allow you to save  
the file.

 
You will hear your narration while it is  

rehearsing or recording. The recording essentially 
records when exactly it should turn to the next 
slide in the show. 

Click > Slide Show > Rehearse Timings.

Create your Video

Save your presentation as a video. Consider your 
usage and bandwidth. 

Click > Save & Send > Create a Video > Com-
puter and HD Displays (Large - 1280 x720).

Upload the Video and  
Email the Link

Upload the video to your Intranet, website, blog, 
or YouTube. Then copy and email the link to your 

6.

7.

5.

4.
8.

9.

10.
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Diana Bentley, Voice and Presentation, In-House 
Perspective, 2009, 11-13. 

Summary: Reviews voice control, training, and 
communication. 

L. Cindy Dabney, The Art of Making Law Library 
Videos: Some Tips for Using Video to Market Your Law 
Library, AALL Spectrum, Feb. 2013, 7-8.

Summary: Canvases the use of a video camera to 
make a short library film. Project planning, software 
considerations, and helpful tips are discussed. 

Lisa Pollack, PowerPoint Over-Reach: Don’t  
Blame the Software, Financial Times (April 21, 2014),  
http://www.ft.com/intl/cms/s/0c8c8e806- 
c61f-11e3-9839-00144feabdc0.
html#axzz30aR0K5NL  

Summary: Focuses on the presentation as a  
function of “storytelling.” Cautions against  
“PowerPoint over ambition.” 

Nathan H. Lents and Oscar E. Cifuentes,  
Web-Based Learning Enhancements: Video  
Lectures Through Voice-Over PowerPoint in a  
Majors-Level Biology Course, 39 Journal of  
College Science Teaching 38-46 (2009).

Summary: Analyzes empirical studies about  
using technology as a teaching tool. Discusses 
PowerPoint videos. 

Sara Kelley, Creating Multimedia Research and 
Software Tutorials with Screencasting Software,  
Law Library Lights (LLSDC, Law Librarians Society 
of Washington, DC) Fall 2007, 17-18. 

Summary: Reviews the process of creating high 
quality legal research tutorials, and examines 
screen recording software. 

Susan Harkins, Pro Tip: Make it Snow in  
PowerPoint, Microsoft.com, March 31, 2014.

Summary: Demonstrates how to create the effect 
of snow falling in the background of your slides. 

audience. You can embed the link for a polished 
look. If the video is uploaded to the Intranet make 
sure you tell users that it can only be viewed from  
a networked computer. 

You have created a law library services video  
using PowerPoint.If you get stuck, please email me.

Selective Bibliography
This bibliography lists articles that are related  

to project planning, presentations, video creation, 
and library marketing. 

Amy Flick, Pick A Quick Flick for Class: How  
to Use Video Clips to Keep Your Legal Research  
Students Awake, AALL Spectrum, April 2011, 18-21.

Summary: Helps you select the best film, sitcom, 
and news clips to add to your legal research  
teaching lecture. Helpful ideas, websites, and  
gives a list of the top ten video clips. 

Bridget MacMillan, Ask the Experts: PR  
Professionals Forecast Trends in Public Relations, 
AALL Spectrum, March 2006, 10-11.

Summary: Weaves PR trends against challenges 
to promote increased library visibility.

Carmine Gallo, Why PowerPoint  
Presentations Always Die After 10 Minutes and How 
To Rescue Them, Forbes.com (April 30, 2014),  
http://www.forbes.com/sites/carmine 
gallo/2014/04/30/why-powerpoint-presentations-
always-die-after-10-minutes-and-how-to-rescue-
them/  

Summary: Attention spans and boredom are 
considered. Suggests “creat[ing] soft breaks every 
10 minutes to reengage your audience.” 

Charles H. Oates, Promoting Your Law Library 
and Fundraising via Multimedia: A Rewarding Team 
Effort, AALL Spectrum, Sept. 1999, 10-11.

Summary: Reports on successful project creation, 
planning, distribution, and analysis. 

http://www.ft.com/intl/cms/s/0c8c8e806- c61f-11e3-9839-00144feabdc0.html#axzz30aR0K5NL  
http://www.ft.com/intl/cms/s/0c8c8e806- c61f-11e3-9839-00144feabdc0.html#axzz30aR0K5NL  
http://www.ft.com/intl/cms/s/0c8c8e806- c61f-11e3-9839-00144feabdc0.html#axzz30aR0K5NL  
http://www.forbes.com/sites/carmine gallo/2014/04/30/why-powerpoint-presentations-always-die-after-10-minutes-and-how-to-rescue-them/   
http://www.forbes.com/sites/carmine gallo/2014/04/30/why-powerpoint-presentations-always-die-after-10-minutes-and-how-to-rescue-them/   
http://www.forbes.com/sites/carmine gallo/2014/04/30/why-powerpoint-presentations-always-die-after-10-minutes-and-how-to-rescue-them/   
http://www.forbes.com/sites/carmine gallo/2014/04/30/why-powerpoint-presentations-always-die-after-10-minutes-and-how-to-rescue-them/   
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As I write what is to be my final column as your president, I can 
reflect upon a very busy year which was exciting, humbling, and  
I hope successful from the viewpoint of our membership.  When  
I began my term last June I thought to myself “what can we  
accomplish?”,  “how can we move forward as the best chapter in 
AALL?”,   and “how can we organize great meaningful events for  
our membership?”  Over the past months hopefully all of those  
queries were answered with energy and determination by me in 
partnership with your executive board.  I am very lucky and  
honored to have served with such a talented and diverse group of professionals.  I can say the successes 
over the past year were due to the board working together and providing essential solutions to the  
challenges presented to us.  

Over the past year, we established a new and updated LLSDC website, presented a bylaw change to 
the membership, transferred the LLSDC archive to a more permanent location, celebrated our 75th  
anniversary as a society, and were honored with the presence of the Law Librarian of Congress David 
Mao as our guest speaker for our annual Town Hall.  A few of our members also attended AALL Lobby 
Day, an annual event at which constituents can meet with their elected officials on Capitol Hill to voice 
support for various library related issues and bills.  In addition, we also organized social events such as 
quiz nights, a baseball game outing, and receptions throughout the year.  

I would now like to take the opportunity to bid a farewell and a big thanks for service to the society 
to our outgoing board members: Scott Bailey (Immediate Past President); Jeff Bird (Treasurer); Alyssa 
Altshuler (At Large Member); Yumi Blackwell (At Large Member).  In addition, I would like to hail our  
new board: Mary Kate Hunter (President), Pam Lipscomb (Vice President); Laura Moorer (continuing/ 
Corresponding Secretary); Jennifer Dollar (Recording Secretary); Doug Tirpak (continuing/Treasurer); 
Emily Florio (Assistant Treasurer); Kris Roth (At Large Member), Emily Carr (At Large Member), Alicia  
Pappas (At Large Member).  Thank you for your initiative and dedication to the society by agreeing to 
serve as board members via our election process.  I would like to give a special thanks on behalf of the 
board to Alicia Pappas who went above and beyond the call as our events coordinator and “Organizer  
in Chief”.  Alicia’s ideas, creativity, and countless hours of her own time to organize the 75th   anniversary  
reception and the other many events presented during the year were greatly appreciated by the board 
and I received numerous positive comments from various members about   the events over the past 
year.  Alicia – thank you!   

In closing, although the winds of change are occurring at the board level, rest assured that you will 
have strong leadership and continuity from our new President Mary Kate Hunter and the new board.  
Mary Kate has a number of new ideas and paths forward and plans to keep our society at the forefront 
of the law librarianship community across the nation.   As I pass the gavel to Mary Kate, I would like to 
say thank you for a great year and thank you for placing your confidence in me as your president.  I am 
humbled and honored to have served as your president.  I bid you all adieu.

Winds of Change
Ed O’Rourke

Manager of Library Services, Baker Botts LLP,  
edward.orourke@bakerbotts.com

President’s Column
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The Future of Law Librarianship:  
An Interview with Mike Timpani 

Real Law Editorial Team
http://www.thisisreallaw.com/hot-topics/2014/06/23/the-future-of-law-librarianship.html 
#sthash.iYJuhs6T.7FJ0Nu19.dpbs

Technology is changing the role of law librarians. 
That reality recently prompted LexisNexis to hold  
a Twitter contest asking law librarians 10 questions 
about their profession for the chance to win a  
trip to the Presidential Library of their choice.  
We received many insightful answers from law 
librarians across the country, including Mike  
Timpani, a law librarian at Orrick, Herrington & 
Sutcliffe LLP and the winner of our contest. He sat 
down with the Real Law Editorial Team to explain 
why he became a law librarian and how he sees the 
role of librarians changing in the future. 

To start off, tell us a bit about  
yourself: how long have you been 
working as a law librarian and  
why did you become one? 

 
I’ve been a law librarian since 1989 when I moved 

from Upstate New York to Washington, D.C., after 
completing graduate school at Clarion University.  
I was interested in working in a larger metropolitan 
area, so I contacted a librarian headhunter asking 
whether there would be jobs available if I made the 
move. The answer was yes, so I packed my bags.

 
I had done papers and theses on being a  

librarian in the law field while in graduate school, 

so it seemed like a natural fit. My first temp job was 
in a law firm library, and from there I moved into 
a number of different roles in the field. I’ve had 
experience in federal agencies and law firms, but 
prefer the latter because they seem to really value 
the role of law librarians and tend to invest more in 
their libraries. 

When we asked you and your  
colleagues what the number one  

http://www.thisisreallaw.com/hot-topics/2014/06/23/the-future-of-law-librarianship.html #sthash.iYJuhs6T.7FJ0Nu19.dpbs
http://www.thisisreallaw.com/hot-topics/2014/06/23/the-future-of-law-librarianship.html #sthash.iYJuhs6T.7FJ0Nu19.dpbs


Law Library Lights Volume 57, Number 4   |   Summer 2014    16

challenge law librarians are facing 
today is, you responded that it  
was keeping on top of all the new  
content that is out there, and the new  
technologies to help you find it and 
get it in the right hands. In a practical 
way, how do you do that? 

The best way to do that is to know who your  
patrons are (the attorneys you’re working for)—
what practice group they’re in and what they’re 
interested in. If you’re working for an insurance 
practice group, then you look for sources and 
materials for insurance people. Once you have that 
information, you get it to them through the normal 
sources—in book format, directories or online.

 

When we asked which current  
trend would trigger the biggest  
challenge for law librarians, you  
mentioned that mobile apps were a 
game changer because you don’t  
have to physically be in the library 
anymore. Do you think that some 
people mistakenly understand the 
end of physical libraries as also being 
the end of the need for librarians?

 
Yes, there are some who have this misconception. 

But those who mistakenly think the end of physical 
libraries means the end of the need for librarians 
are typically those who don’t use the library, like 
accountants or the board of an organization. They 
see the overhead of running a library and think 
that since everything is going mobile, there’s no 
longer a need for the physical space or staff. 

However, attorneys still like to have a central 
source physically and a human resource that they 
can rely on to find them specific information.  
Instead of just generally directing them towards  

a book, we can get them exactly what they’re  
looking for, in person or electronically. Your  
perspective on the future of law librarians is  
interesting (and reflects what a lot of your  
colleagues think): “Our role really hasn’t changed; 
it’s still about facilitating our patrons’ information 
needs. It’s only how we do it that has changed.”

What are some of the skills you think 
the librarian of the future  
will need to master? 

The most important skill for future law librarians 
will be adaptability. Back in the ’60s, ’70s and ’80s, 
the role of a law librarian was very specific, but  
as information resources are changing, the role  
is becoming less defined and is more diverse,  
depending on the type of organization the  
librarian is in. So while the librarian’s primary  
role will continue to revolve around finding  
specific information for their patrons, that role  
may take less time with increasingly faster  
e-resources. The law librarians of the future will 
need to take on other tasks; for example, maybe 
writing briefs or doing paralegal work to increase 
their value to the organizations that employ them. 

The prize for this contest was a trip 
to the Presidential Library of your 
choice. Have you decided which  
one you will be visiting?

I haven’t yet decided which library I’d like to  
visit, but I’ve narrowed it down to either the  
Ronald Reagan Presidential Library or the Nixon 
Presidential Library. I’ve never been to California 
and think this would be the perfect opportunity  
to both visit a great Presidential Library and  
explore a different part of the country.
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Law School Casebooks:  
Is Innovation Imminent  
or Impossible? 

Roger V. Skalbeck
Associate Law Librarian for Electronic Resources & Services,  
Georgetown Law Library, rvs5@law.georgetown.edu

Tech Talk

One part of my first law library job ever was to review attorney book donations to consider what to 
add to the firm’s collection.  At the time, we still had lots of books. We had case reporters, Shepard’s 
volumes and even Martindale-Hubbell.  There were a few eternally empty spaces on the shelves for 
volume three of Newberg on Class Actions and two volumes of Wright and Miller.  Surprisingly, we  
also had some shelf space. 

I aimed to fill these empty shelves.  I guess I figured if “books are for use” then “shelves are for books.” 
I naively wanted to keep seemingly useful titles like “Law of Contracts” and “Law of Torts.”  These books 
looked important, and were always in near-mint condition.  What I quickly learned is that these were 
casebooks, and they had no place in our law firm library’s collection.  Clearly they also had no place in 
our law firm attorney’s collection, which is why we received them.

Fast forward two decades or so, and I still work in a library that gets donations of mint-condition  
casebooks.  Though we keep some of them on the shelves, they have just as little research value for us 
as they did for practicing attorneys at the time.  Casebooks may be great instructional tools, but they 
have near zero long-term value for a library’s collection.  

Considering today’s casebooks, it is amazing that there has been so little innovation with this  
format over the years.  Thankfully, there are a few important efforts to change the world of law school 
casebooks. In this Tech Talk installment, I look at non-commercial approaches to publishing innovative 
electronic casebooks. If these publishing models are ever adopted broadly, maybe we will stop  
accepting these useless donations.
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CALI eLangdell: eBooks for Legal Education
Christopher Columbus Langdell championed 

possibly the longest-standing innovation in 
legal education:  the case method of instruction.  
The Center for Computer-Assisted Legal Instruc-
tion (CALI) incorporated his namesake into their  
all-electronic collection of law books, naming  
it eLangdell. (http://elangdell.cali.org/).

Paraphrasing their promotional material,  
CALI bribes law faculty to publish open texts  
and they encourage people to steal them, as 
long as it’s not done to make money.  Though 
their methods and imagery are somewhat 
tongue-in-cheek, their products are very  
serious.  For every new casebook title or chapter 
they publish, they are offered for free download 
in five formats.  This includes Word, PDF and the 
two dominant e-reader formats:  ePub and Mobi 
for Kindle users.  The final format is print.  People 
can, and do, opt to get these innovative texts in 
dead tree versions, ordered through Lulu.com.  
The most expensive title in the CALI eLangdell 
collection is less than $30 for a hardcover  
evidence book.

Tech Talk, Continued

Though their publishing practices are  
unorthodox, the process for selecting texts  
is still fairly traditional.  Authors create a  
manuscript with a word processor, submit it to 
editors and revise content until its ready.  It  
takes anywhere from six weeks to eighteen 
months to publish a new casebook, which is  
entirely dependent on the professor’s  
intellectual contributions.

CALI expects participating authors to provide 
teacher’s notes and update their works as the law 
changes.

 
H2O: Online Classroom Tools
The Berkman Center for Internet & Society, in 

collaboration with Harvard Law School Library, 
developed the H2O platform (http://h2o.law.
harvard.edu/) as a set of tools for faculty to  
assemble, customize, remix and publish  
online-only casebooks.  One underlying goal 
of this project is to replace the traditional print 
casebook. An aspirational goal is to completely 
replace all casebooks used in the first year  
of law school.  

http://elangdell.cali.org/
http://h2o.law.harvard.edu/
http://h2o.law.harvard.edu/
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This web-based platform provides tools for 
faculty to select, edit and arrange cases as well  
as other texts and links. These materials are  
compiled into a single collection suitable for a 
law school course.  The H2O platform is in use  
at Harvard, Stanford and other schools.  It is  
used for first year courses such as torts and  
criminal law, as well as upper division and  
seminar courses.

Tech Talk, Continued
Materials for a course are built by selecting 

from a menu of content types that include cases, 
user-created text, links, videos and other objects.  
These objects are further customized by editing 
out unnecessary elements, which faculty arrange 
in a customized sequence. 

An example from a seminar called Music & 
Digital Media at Harvard Law School shows a 
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Tech Talk, Continued
structured outline with a combination of book 
chapters, statutes, and lots of cases organized 
into a faculty-created topical sequence.   
A compelling feature of the H2O platform lets 
any contributing authors take existing works and 
remix them.  With this, each professor can have a 
unique collection of materials for every semester, 
updated with the latest cases and references.

Small Press and Self-Publishing
Two remaining electronic casebook publishing 

examples are worth noting. With both of these 
options, the works are protected by traditional 
copyright, other than the non-protectable cases 
themselves.  The innovation with each example 
is that they are published as PDF files with no 
technical restrictions preventing copying,  
printing or annotations.

Semaphore Press
http://semaphorepress.com/ 
This is a small publisher that offers four  

casebook titles where students set the price 
they’re willing to pay for each title.  The  
recommended cost is $30, but there’s an option 
to freeride (download for free), for people who 
want to consider a book before buying it.   
The press has a very sensible return policy for 
people who buy a text and subsequently drop 
the course where it was used. 

Gumroad
https://gumroad.com/l/zPsX 
This platform has nothing to do with legal 

publishing.  It is simply the place that Professor 
Rebecca Tushnet and Eric Goldman have chosen 
to sell their self-published casebook on  
Advertising & Marketing Law.

Casebook Conclusions
Choosing to innovate with a casebook  

platform is not a decision made quickly.   
In researching these electronic publishing  
alternatives, casebook authors report that a 
comprehensive project can take a long time to 
develop.  A professor at the University of Virginia 
who published an eLangdell Contracts casebook 
worked on his content for more than six years, 
while Professors Tushnet and Goldman spent 
around five years from the time they conceived 
the idea until publishing a work they say is “only 
about 90% done.”

It is promising to see innovative professors 
focused on adapting this nearly 150-year-old 
concept to modern times.  These models suggest 
that there are far cheaper and far more useful 
ways to provide materials to help law students 
learn the law.  

Maybe someday we’ll start to see fewer of 
these donations we will politely turn down in  
our law libraries.  Stay tuned for an innovative 
casebook revolution.  Just don’t start chilling  
the champagne just yet.  It might need to age a 
few more years before we can truly celebrate.

http://semaphorepress.com/  
https://gumroad.com/l/zPsX  
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